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1. Close Look into a Certain Region Only

1.1. Viewing within Clipping Box
Users can specify a view area in the point cloud by creating a rectangular solid. This
rectangular solid is called a "clipping box." Users can view data within the clipping box or move
the data to another layer for editing.

Preparing to Create Clipping Box

If the buttons on [Clipping] panel are inactive, activate them by pressing [Switch Mode:
Clipping/Section] (  ) in the upper left of [Clipping] panel.

 Clipping Box and Section cannot be used at the same time.

1. In [Clipping] panel, press [Create clipping box]  ).

2. Pick a point on the screen to select an area to clip out.
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With the selected points in the center, a semi-transparent blue box will appear on "3D View"
window. This box is the "Clipping Box".

3. Left-click and drag the handles that appear around the Clipping Box to adjust the size and
orientation. Types of handles are as follows:

◦ Handle in the width direction ( )

◦ Handle in the height direction ( )

◦ Handle in the depth direction ( )
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◦ Rotation handle for axis in the width direction ( )

◦ Rotation handle for axis in the height direction ( )

◦ Rotation handle for axis in the depth direction ( )

Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

 © 2022 Elysium Page 3 | 164





By pressing [Restore to Initial Rotation Angle] ( ) in [Clipping] panel,
you can reset the rotation angle of Clipping Box to the initial state.

Right-click and drag the handle with the mouse to parallel move the
Clipping Box without changing the size.

4. When enabling "Show only the points within Clip Box" in [Clipping] panel, only the elements
inside the Clipping Box are displayed.
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1.2. Viewing the Section
Users can create sections to specify the display area of the data. A plane is used to create a
section.

Preparing to Create a Section

If the buttons in [Section] panel are inactive, activate them by pressing [Switch Mode:
Clipping/Section] ( (  ) on the upper left of [Section] panel.

 Clipping Box and Section cannot be used at the same time.

1.2.1. Creating a Section by Using XY Plane

1. Select [XY(Top)] (  ) from the [Section] panel.

2. Pick points to create a section on the 3D View Window.
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3. A section will be created at the picked point position.



◦ You can switch show/hide of the section in the 3D View Window by
using "Hide points outside section" or "Display the section" in the
[Section] panel.

◦ Please note that you can adjust the position of the section by clicking
(   ) and moving the slider in the [Section] panel.

Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

 © 2022 Elysium Page 6 | 164



1.2.2. Creating a Section from Any Plane

1. In [Section] panel, press [Section using selected plane] (  ).

2. Select an extracted plane where you would like to create the section.

 Perform [Extract Planes and Pipes] before creating a section.

3. A section will be created at the picked position of the plane.
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1.2.3. Creating a Section by Using [Top]/[Front] Panel



To create a section in [Top View] panel (or [Front View] panel), enable "Enable
Clipping Box/ Section creation by dragging" in [Top View] panel (or [Front
View] panel) settings dialog.

1. Users can create section by clicking and dragging the mouse in the [Top] panel or [Front]
panel.

2. The section will be created on [Top] (or [Front]) panel view.

 The section is displayed by blue line for [Top] or [Front] panel.
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The section will be displayed on the 3D View Window at the same time.

About Display Area

You can change the display area of the section by [Section] panel > "Display area".

■ Plus side: Display the points in the plus side of the section only
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■ Minus side: Display the points in the minus side of the section only

■ With thickness: Display the points in the section with specified thickness only
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1.3. Saving a Scene
In InfiPoints, the below information can be registered as [Scene]. And you can also register
multiple scenes and switch back and forth.

Information that can be saved in "Scene"

• Viewpoint

• Layer information of Display status/Display color

• Display status / Location of CAD Model

• Display status / Location of Point Cloud

• Clip Box/Section

1.3.1. Register a Scene

1. Select [Home] tab > [Show/Hide Panels] > [Scene] panel. Scene panel will be displayed.

2. Move to the location where you would like to save the view point.

Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

 © 2022 Elysium Page 11 | 164




For details about 3D View Window operation, refer to [View Operation] in
[InfiPoints Operation Manual (Data Pre-processing)].

3. In [Scene] panel, press [Add] (  ). The information enabled in "Item to Restore" dialog is
registered as one scene in the list.



A context menu will be displayed when right-clicking on the scene in the
list. Edit the name of the scene using [Rename].

4. To delete a scene, specify which scene to delete and press [Delete] (  ).
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1.3.2. Items to Restore

1. When pressing [Items to Restore] (  ) in [Scene] panel, "Items to Restore" dialog will
appear. Enable the items you wish to apply and click [OK].

2. Double-click on the scene in the list to display the specified scene in the 3D View Window.

 Use [Apply this scene] in the context menu to switch to a certain viewpoint.
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1.4. Saving an Area of Specified Space
In InfiPoints, an area of space enclosed by a box can be registered as a "Zone". Multiple zones
can be registered, and switched among them.

Zone can be used to achieve the following behavior:

• Displaying the area on "3D View" window or Top View / Front View.

• Searching for notes or models within the area.

• Check if there is another zone that interferes.

1.4.1. Create Zone from Clipping Box

Create a zone in the position of the currently set Clipping Box.


Please ensure to switch [Switch Mode: Clipping / Section] (  ) icon to
[Clipping] in advance, and set Clipping Box at the position where you want to
create a zone.

1. Select [Home] tab > [Zone] > [Create Zone] > [Create from Clipping Box] (  ) from the
ribbon menu.
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Zone is created at the Clipping Box position.

Newly created zone will appear in the structure tree and [Zone] panel as well as on "3D
View" window.

1.4.2. Create Zone in Section Mode (Specify horizontal section)

Create a zone by specifying any place you prefer on the horizontal section.

1. Select [Home] tab > [Zone] > [Create Zone] > [Create in Section Mode] (  ) from the ribbon
menu.
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2. "Create Zone in Section Mode" dialog will appear. Select "Create a horizontal section at
specified height", and click [Next].

In "Option" dialog, you can specify Zone color, Zone transparency, Zone thickness from the
section, and Zone axis (Rotation angle). In this case, set the thickness as follows.

3. Specify an origin of the horizontal plane which will be used as the section on "3D View"
window. Here, pick a point from the floor.
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4. The view on "3D View" window switches to "Section Mode", and the viewpoint is from
above, looking down on a section cut at the floor level.



If the area cut in the section is hard to see, from [Section] panel, enable
"With thickness" of Display Area and adjust the width, making it easier to
see.

5. On "3D View" window, click the upper-left position of the zone you want to create, and a
rectangular guide will appear. Then click the lower-right position, and a zone will be
created.
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6. To continue creating more zones, click the upper left position of the zone that you want to
repeat creating. Press [Cancel] (  ) to quit.
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1.4.3. Create Zone in Section Mode (Using Clipping Box)



Please ensure to set Clipping Box in advance when you want to create a zone
by switching from Clipping Box to "Section Mode". Refer to "1.1, “Viewing
within Clipping Box”" for the setting method.

1. Select [Home] tab > [Zone] > [Create Zone] > [Create in Section Mode] (  ) from the ribbon
menu.

2. "Create Zone in Section Mode" dialog will appear. Select "Use current section / Clipping Box",
and then click [Next].

In "Option" dialog, you can specify Zone color, Zone transparency, Zone thickness from the
section, and Zone axis (Rotation angle).
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3. "Section Mode" orientation ("Side" or "Top") in [Clipping] panel switches the specified
section to be viewed from above orthographically.

4. On "3D View" window, click on the upper-left position of the zone you want to create, and a
rectangular guide will appear. Then click on the lower right position, and a zone will be
created.

5. To continue creating more zones, click the upper left position of the zone that you want to
repeat creating. Press [Cancel] (  ) to quit.
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1.4.4. Edit Zone

1. Select [Home] tab > [Zone] > [Edit Zone] (  ) from the ribbon menu.

2. Select one zone to edit from either [Tree] panel (structure tree) or "3D View" window.
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3. Handles will appear around the specified zone on "3D View" window.
Click and drag the handle with the mouse to adjust the size and orientation of the zone.


Please note that this handle operation is the same as that of Clipping Box.
Refer to 1.1, “Viewing within Clipping Box” for the operation method.
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2. Editing Point Cloud Color
By editing the image associated with point clouds, the color of point clouds can be corrected.

1. Select [Pre-process] tab > [Point Cloud Color] > [Edit Color] (  ).

2. Specify the point cloud parts or groups to edit the color in [Tree (Overview)] panel, and
press [Done] (  ).

3. "Point Cloud Color" dialog will appear. Select "Edit a Copy" option.
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4. "Edit Color in Images" dialog will appear. Specify the image to edit, and select [Open with
Editor] ( ). To select multiple images, select the items while holding down [Ctrl] or [Shift]
key.



◦ Confirm the image with the Viewer either by double-clicking the image
on the list, or by specifying the image and select [Open with Viewer]
( ).

◦ Viewer / Editor applications can be changed from [Settings] ( ) at the
top right of "Edit Color in Images" dialog.



◦ Please ensure to always use [Rotate] ( ) in "Edit Color in Images"
dialog when changing the direction of image in the list. An error may
occur during the process if you change the direction of the image in the
image viewer or image editor.
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5. Editor will be launched and the image will be displayed. Overwrite the image after
correcting the image color.

 Please ensure to update the edited images by saving them.

6. Click [OK] in "Edit Color in Images" dialog.

7. When the confirmation dialog appears, click [Yes]. The point cloud color is updated to match
the color of the edited image.

◦ An example of adjusting the image brightness
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3. Complementing Point Cloud

3.1. Complementing Point Cloud - Under the Scanner
Generally, a floor area where a 3D scanner is placed cannot be scanned, resulting in a blank
area without point cloud. Use the following procedures to create a point cloud to complement
this blank area.

1. Select [Pre-process] tab > [Optimize] > [Complement Point Cloud] > [Floor under Scanner]
(  ).

2. In [Option] panel, specify the mode and adjust the resolution.
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

◦ Select "Smooth Connection" to create a point cloud that complements
the surrounding geometry. (bottom left figure)

◦ Select "Complete the floor as a plane" to create a point cloud that
complements within the specified tolerance without considering the
surrounding geometry. (bottom right figure).



By using resolution, adjusting the resolution of complemented point cloud
is possible.
[Example] Lowest resolution (on left) and highest resolution (on right)

3. Select the point cloud part or group to complement in [Tree (Overview)] panel.
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

Please note that this function can only be used for point cloud with scan
index data.

The process to complement the point cloud will start.

4. After completing the process, a new point cloud with scan index data that complements the
floor underneath the scanner is created in [Tree (Overview)] panel.
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3.2. Removing an Object on the Floor
Points corresponding to the object can be automatically recognized on "3D View" window and
moved to the specified layer.



When using this function, it is recommended to use filtered point cloud data.
Please note that if point clouds other than filtered point cloud data are
displayed, processing may take a considerable amount of time.

Please refer to "Learn with Tutorial" > "Vol.1. Data Pre-processing" > [Creating
Point Cloud Data Optimized for Visualization]" for more details about creating
filtered point cloud data.

1. Select [Pre-process] tab > [Optimize] > [Complement Point Cloud] > [Space after Removing
Object] (  ).

2. In [Option] panel, select "On the floor / Away from walls" option.
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

◦ Enable "Create a new point cloud from the removed object" to create a
new point cloud part (Removed_object) from the red highlighted points.

◦ Enable "Auto-complete the created hole" to create a new point cloud
part (Inpainted_hole) to complement the hole after object removal.

3. Select a plane on "3D View" window which will be the floor.

4. Select the highest point on the object from the selected floor.

5. A dialog will appear. Specify the target layer.
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6. Adjust the slide bars while previewing on "3D View" window.

7. Click [OK] to move the point cloud to the target layer.
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3.3. Complementing Point Cloud - within Specified
Region
Point cloud which complements the missing part of a specified plane region can be created.



When using this function, it is recommended to use filtered point cloud data.
Please note that if point clouds other than filtered point cloud data are
displayed, processing may take a considerable amount of time.

Please refer to "Learn with Tutorial" > "Vol.1. Data Pre-processing" > [Creating
Point Cloud Data Optimized for Visualization]" for more details about creating
filtered point cloud data.

1. Select [Pre-process] tab > [Optimize] > [Complement Point Cloud] > [On Specified Plane]
(  ).

2. Select "Specified region only" option in [Option] panel.
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
Check "The entire plane" option in [Option] panel to create point clouds in
all regions of the selected plane.

3. Select "Blend with surrounding points" in [Option] panel for the coloring method.



When selecting "Specify color" option in [Option] panel, you can set any
color to the newly created point cloud.

4. Select a plane in "3D View" window which will be the floor.

Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

 © 2022 Elysium Page 34 | 164



5. Click on "3D View" window to specify the region to complement.

Finally, click the starting point to begin the process of complementing the point cloud.

6. When processing is completed, a new point cloud part (Inpainted_plane) is created which
complements the area of the plane specified in [Tree Overview)] panel.
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4. Creating and Editing Texture
Texture images can be created from the point clouds for planes and pipes. You can significantly
reduce the view operation of InfiPoints by only displaying the texture without displaying the
point cloud.



When using this function, it is recommended to use filtered point cloud data.
Please note that if point clouds other than filtered point cloud data are
displayed, processing may take a considerable amount of time.

Please Refer to "Extracting Planes and Pipes" in "Elysium InfiPoints Operation
Manual Vol.1. Data Pre-processing" > [Creating Point Cloud Data Optimized for
Visualization] for details about creating filtered point cloud data.

4.1. Creating Texture Images
It is possible to create texture images from the point clouds for planes or pipes.

4.1.1. Creating Texture Image from Planes

1. Select [Pre-process] tab > [Texture] > [Create] > [All Planes] (  ).

2. "Create Texture for All Planes" dialog will appear. Specify options such as clearance and
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resolution, and click [OK].



◦ With clearance, you can specify which area of the point cloud from the
plane to use when creating a texture image.

◦ With resolution, you can specify the actual length that corresponds per
pixel of the texture image (detail texture) to be created. The smaller the
actual length corresponding per pixel, the higher the resolution.

▪ Resolution 0.01 m/px (Left) and 0.001 m/px (Right)

◦ When "Enhance created texture by image auto-correction" is enabled,
the quality of the texture image can be improved automatically. This is
effective for areas with low point density.

The process to create texture will start. Required time can be seen in the progress bar. When
you are done, click [OK].
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Texture images are created for all the plane elements.


Please note that when you create texture only for the plane element
specified in [Plane] (  ) and switch to [Texture], the plane element
without texture will be shown in white.

4.1.2. Creating Texture Image from Pipes

1. Select [Pre-process] tab > [Texture] > [Create] > [All Piping Elements] (  ).

2. "Create Texture for All Pipes" dialog will appear. Specify options such as clearance and
resolution, and click [OK].
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

◦ With clearance, you can specify which area of the point cloud from the
pipe’s surface to use when creating a texture image.

◦ With resolution, you can specify the actual length that corresponds per
pixel of the texture image (detail texture) to be created. The smaller the
actual length corresponding per pixel, the higher the resolution.

▪ Resolution 0.01 m/px (Left) and 0.001 m/px (Right)

◦ When "Enhance created texture by image auto-correction" is enabled,
the quality of the texture image can be improved automatically. This is
effective for areas with low point density.

The process to create texture will start. Required time can be seen in the progress bar. When
you are done, click [OK].
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Texture images are created for all the piping elements.



◦ Please note that "Straight pipe" is the only selection available in [Piping
Element] (  ). Specifying only the connection element is not
available; however, when you create texture on a straight pipe,
adjacent connecting elements will be displayed in a single color similar
to the texture of the straight pipe.

◦ Please note that when you create texture only for the pipe element
specified in [Piping Element] (  ) and switch to [Texture], the pipe
element without texture will be displayed in white.

4.1.3. Toggling between Default Color and Texture

1. Select [Home] tab > [Show / Hide Point Cloud] and click [Hide Point Cloud] (  ).
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Point cloud will be hidden. At this point, the planes and pipes are shown in the state of
default.

2. Select [Home] tab > [Display Status] > [Display Method of Plane Elements] and click
[Texture] (  ).

The plane on which the texture image is being created switches to texture display.

3. Select [Home] tab > [Display Status] > [Display Method of Piping Elements] and click
[Texture] (  ).
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The pipe on which the texture image is being created switches to texture display.
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4.2. Editing Texture Color
It is possible to correct the hue of texture images created on planes and pipes.

1. Select [Pre-process] tab > [Texture] > [Edit] (  ).

2. On "3D View" window, select a plane element or a piping element whose texture image you
want to edit and press [Done] (  ).

3. "Edit Texture Image" dialog will appear. Specify the preferred image to edit, then select
[Edit] > [Detailed Image Only]. To select multiple images, select the images while holding
down [Ctrl] or [Shift] key.
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

◦ Confirm the image with the Viewer either by double-clicking the image
on the list, or by specifying the image and select [Open with Viewer]
( ).

◦ Viewer / Editor applications can be changed from [Settings] ( ) at the
top right of "Edit Color in Images" dialog.

4. Editor will be launched and the image will be displayed. Overwrite the image after
correcting the image color.

 Please ensure to update the edited images by saving them.

5. In "Edit Texture Image" dialog, click [OK].

6. A "Confirmation" dialog will appear. Click [Yes] to update the texture color to match the
color of the edited image.
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◦ Example of removing unnecessary parts from an image
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5. Moving Tools

5.1. Moving Specified Element
Use moving tool to move the element in "3D View" window.

1. Select [Analysis] tab > [Move] > [Move] (  ).

2. Select the point cloud part to move in [Tree (Overview)] panel.



Select a group in [Tree (Overview)] panel to move per group.

When a point is selected on "3D View" window, point cloud part containing
the selected point is moved.
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3. Move the scan shot using the handle which is shown around the scan shot in the 3D View
Window.

The "Move" dialog will appear as well.

4. Drag the yellow moving handle to move the point cloud part parallel along the world
coordinate system.
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

When using "Move" dialog, specify the values in "Translate distance" on
[Parallel move] tab, and click [Apply].

Drag the blue moving handle to rotate around the specified axis in [Rotation move] tab of
"Move" dialog.



When using "Move" dialog, specify the angle in "Rotation angle" on
[Rotation move] tab, and click [Apply].

Select the axis from pull-down list on [Rotation move] tab to easily specify
the axis which will be the center of rotation.
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5.2. Position the CAD Model in Place
Position the CAD model based on the specified plane or cylinder’s center axis.

1. Select [Analysis] tab > [Move with Constraint] (  ) from the Ribbon menu.

2. Select the CAD model to move in "3D View" window.


The only elements allowed to use [Move with constraints] are "CAD model"
and "plane group".

3. "Move with constraint" dialog will appear. Press [Constraints by axis] (  ) from the
conditions for constraints.
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4. Select a face of the CAD model to be the base.

 The only face that can be selected is cylindrical face.

5. Select one piping element whose axis should be aligned with the center axis of the
cylindrical face specified in the CAD model.

CAD model will move as the center axis of CAD model’s cylindrical face which overlaps the
center axis of the specified piping element.
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6. Press [Constraint by plane] (  ) from the conditions for constraints.

7. Select a face of the CAD model to be the base.

8. Select one plane to match the basic face of the CAD model.
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CAD model will move to match the specified plane and the reference face of CAD model.

9. At the same time, "Set offset" dialog will appear. In this case, specify "-0.1" (m) as the offset
distance, and click [OK].
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
If you do not want to set a gap between the specified plane and the CAD
model, leave the offset distance as "0 (zero)" and click [OK].



Moving parallel (  ) or rotating the target model (  ) can even be
done with constraint by plane or constraints by axis.
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6. Edit Layers
In [Layer] panel, the following operations can be performed by classifying points in the point
cloud part into layers.

Toggle show / hide the points per layer

• When all layers are shown

• When some layers are hidden

Set color per layer

Generate a polygon from points in the layer
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The following functions are available when classifying each point in a point cloud part into
layers.

• Remove noise
Point cloud can be classified into each layer automatically according to the noise type.

• Editing with [Layer] panel
Point cloud can be manually classified into each layer, such as specifying a region or object,
and moving the surrounding points to a specified layer.
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6.1. Move Points in Layers
Move the point cloud to the specified layer.

■ Change the layer by specifying the area

On "3D View" window, enclose the area you want to move by the function [Rectangle], and
move the point cloud enclosed in rectangle to another layer.

1. Select [Pre-process] > [Layer] > [Enable Layer Edit] (  ) from the Ribbon menu.

2. [Layer] panel is displayed in editing mode. Select the layer number in "Target Layer" to
which the point cloud will be moved. The selected layer will have a "yellow" background
color in the list.



In [Layer] panel, you can specify the target layer for the point cloud in two
places: "Target Layer" and "Target Layer (Press Shift)".

The point cloud selected while pressing [Shift] key is registered in the layer
specified in "Target Layer (Press SHIFT)". For the layer specified in "Target
Layer (Press Shift)", the background color in the list will be "light green".
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

If an unused layer is selected, the "Change Name" dialog will appear.
Specify a layer name.



The name can also be changed from the context menu by right-clicking on
the name of each layer, then changing the layer name from "Rename".

3. The [Clipping Box/Section] (  ) is selected in the [How to select points] panel.

On "3D View" window, hold down [Ctrl] key + left-click the mouse button and drag to select
the area. The inside of the rectangular area, which is enclosed with a white line, can be
previewed on "3D View" window.

Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

 © 2022 Elysium Page 57 | 164





You can also restrict the depth of the rectangular area in [Option] panel.

When you release left mouse button, the point cloud moves to the layer specified by "Target
Layer".



Point cloud which you selected by dragging while holding down [Ctrl] key +
[Shift] key + left mouse button on "3D View" window moves to the layer
specified in "Target Layer (Press Shift)".
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■ Changing the Layer with Clipping Box

Use Clipping Box to trim and divide the point cloud of facility to another layer.

1. Select [Pre-process] > [Layer] > [Enable Layer Edit] (  ) from the Ribbon menu.

2. [Layer] panel is displayed in editing mode.
Set the layer number for "Target Layer" so the equipment’s point cloud will move there.

3. The [Clipping Box/Section] (  ) is selected in the [How to select points] panel.

"Edit Points (Clip Box / Section)" dialog will appear.
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4. Users can specify a point cloud area using the [Create Clipping Box] (  ) in "Edit Points
(Clip Box / Section)" dialog.

Specify the range of Clipping Box on "3D View" window, and press [Done] (  ).


Please refer to "Viewing within Clipping Box" for ways to create a Clipping
Box.

5. In "Edit Points (Clip Box / Section)" dialog, select "By Clipping Box" and click [OK].
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The point cloud in Clipping Box will move to the specified layer.



Point clouds can be selected by using the following ways as well as
[Clipping Box/Section] (  ).

◦ Rectangle (  ), Free Form (  )

◦ Sphere (  ), Cylinder (  )

◦ Piping Group (  ), All Piping Elements (  )

◦ Plane (  ), All Planes (  )

◦ Duct Group (  ), All Duct Elements (  )

◦ CAD Model (  ), All CAD Models (  )

◦ Polygon Model (  ), Polygon Models (  )
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6.2. Copy Point Cloud Element of Layer
New point cloud part can be created from a point cloud separated into other layer.

1. Move only the point cloud, which will be copied to new point cloud part, to any layer.

2. Right-click on the target layer of which the moved point cloud belongs, and select "Copy to
new point cloud" in the context menu.

3. The following dialog will appear.
Specify the target layer and the maximum number of points for the point cloud part to be
created, and click [OK].

Creation of point cloud part will start.
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

If the copied points exceed the specified number of points, a confirmation
dialog appears.
Click [OK] to proceed with the process.

4. Once the point cloud part has been created, it will appear on [Tree Panel (Overview)] panel.

Created point cloud part will move to the layer specified as target in [Layer] panel.


Point cloud part name and layer name are the same as the layer name for
which "Copy to new point cloud" was executed.
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6.3. Confirm the Number of Points in the Layer
The number of points per layer can be confirmed.

1. Right-click on the layer, and then select [Calculate Number of Points] from the context
menu.

Number of points is displayed in the "No. of points" column of [Layer] panel.

When switching show / hide of point cloud in [Tree (Overview)] panel, the number of points
changes according to the layer.

◦ When all point cloud parts are displayed in the structure tree
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◦ When portion of point cloud part is displayed in the structure tree
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6.4. Layer Panel Basic Operation

6.4.1. Toggle Layer Display

Toggle show/hide the point cloud in each layer. For example, by hiding layers classified as noise,
the noise point cloud on "3D View" window will not appear, and improves the appearance.

1. Check Off the checkbox of each layer to hide the point cloud classified to that layer on "3D
View" window.

◦ When all layers are shown

◦ When noise layer is hidden


Hidden point cloud layers will not be used to process data such as in the
case of feature extraction.



If you click [All Show] in "Selectable", all checkboxes can be enabled at
once. Also, if you click [Invert Show], you can invert the On / Off status.
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6.4.2. Searching for Layers

You can search for layers in the layer list.
When the search box at the top of [Layer] panel is blank, all layers will appear in the layer list.
When entering a string in the search box, only the layers whose "name" contains the string will
be displayed in the layer list.

• When the search box is blank

• When a string is entered in the search box
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6.4.3. Set Layer Color

Specific color can be set for each layer.

Layers without any color settings will be displayed as ‘ - ’ and the points will be displayed in
original colors.

1. Right-click on a layer, then select [Set Color #1] in the context menu.

2. A "Color" dialog will appear. Specify the color you want to set, and click [OK].



Also, the "Color" dialog will appear when left-clicking a layer’s "Color 1"
column.

Point cloud included in the layer will be displayed in the specified color.
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3. Select [Clear Color] in the context menu to clear the color settings of the layer.



A gradation of [Color1] and [Color2] will be displayed when a color is set for
[Color2].
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6.4.4. Control Layer Selection

Users can switch whether the layer will be selectable or not for layer editing.

For selected layers, a "✓" mark is displayed in "Pickable" cell. For layers without "✓" mark
including the point cloud, you cannot select the point cloud on "3D View" window.

1. Right-click on the layer you want to remove from selection, then click [Clear Selectable] in
the context menu.

The "✓" mark in "Pickable" column of [Layer] panel will be hidden. Point clouds included in
layers with "✓" mark hidden in "Pickable" column will not be affected by any operations on
"3D View" window.



Users can also left-click on [Pick] column "✓" to toggle the cell On / Off. If
you click [All Show] in "Selectable", "✓" will be displayed on all layers. Also,
if you click [Invert Show], you can invert the On / Off status of "✓" .
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7. Generating/Exporting Polygons

7.1. Generating Polygons from Point Clouds in a
Specific Layer
Generate a polygon data from point cloud data imported into InfiPoints.

7.1.1. Run from Ribbon Menu

1. Select [Generate Polygon] (  ) in the [Pre-process] tab.

2. "Generate Polygon" dialog will appear.

Select the layer to translate into polygon data in [Layer] panel.

 Multiple layers can be selected by holding down [Shift] key or [Ctrl] key.
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3. Specify the method to generate a polygon. Select "Create smooth / simple outline ignoring
the noise", and click [OK].

4. "Generate Polygon" dialog will appear. Adjust "Mesh fineness" and "Trimming area", and
then click [OK].



◦ Enable "Create a single polygon model from multiple point cloud parts"
to create a single merged polygon model from the point cloud parts.
When disabled, a polygon is generated per point cloud part.

◦ Enable "Create a single polygon model from multiple layers" to create a
single merged polygon model. When disabled, a polygon model is
generated per layer.

5. The process of generating polygons will start.
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After completing the process, a newly generated polygon is added to [Tree (Overview)]
panel.

7.1.2. Run from Context Menu of [Layer] Panel

1. Select [Show/Hide Panels] (  ) in the [Home] tab and display the [Layer] panel.

2. Right-click the selected layer to translate into polygon data. Select "Preserve the details"
from the context menu.
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 Multiple layers can be selected by holding down [Shift] key or [Ctrl] key.

3. "Generate Polygon" dialog will appear. Adjust "Max. allowed gap between polygon and point
cloud" and "The Number of Polygons". Click [OK].



◦ By reducing the value of "Max. allowed gap between polygon and point
cloud", finer polygons are generated. Note that the polygon face may
not be filled correctly when the value is too small.

◦ If the polygons are not generated in the intended shape, adjust the
setting and run the polygon generation command again.



◦ Enable "Create a single polygon model from multiple point cloud parts"
to create a single merged polygon model from the point cloud parts.
When disabled, a polygon model is generated per point cloud part.

◦ Enable "Create a single polygon model from multiple layers" to create a
single merged polygon model. When disabled, a polygon model is
generated per layer.
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4. The process of generating polygon will start.

After completing the process, a newly generated polygon is added to [Tree (Overview)]
panel.
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7.2. Exporting Generated Polygon Data
Generated polygons can be exported to a variety of formats.
Operation differs between exporting as DWG/DXF formats and exporting as STL/OBJ/VRML
formats.

7.2.1. Exporting DWG/DXF files

1. Select the polygon element to translate into polygon data from the structure tree of [Tree
(Overview)] panel. Right-click on the element, and select [Export Drawing] from the context
menu.


◦ The above menu might not be shown when the clipping box creation,

dimension measurement, or other certain process is running.

◦ In that case, finish the process before the export.

2. The following dialog will appear. Click [OK].

3. "Save As" dialog will appear.
Select the type of file to save, specify the filename and where to save, and then click [Save].
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7.2.2. Exporting STL/OBJ/VRML file

1. Select [Output Creation] tab > [Export] > [Polygon Model] (  ) from the Ribbon menu.

2. "Export" dialog will appear.
Select the file type (STL/OBJ/VRML), specify the location to save the file and the filename,
and then click [Save].
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
If multiple polygon elements are included in the project file, all polygon
elements will be exported.



Go to [Option] for detailed settings.
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8. Measuring

8.1. Measuring Volume and Surface Area
Measure the volume, surface area, and base area within the specified range.

1. Select [Home] tab > [Measure] > [Measure Volume] (  ).

2. Pick to enclose the area you want to measure on "3D View" window, and then press [Done] (
 ).

3. The setting dialog will appear. To specify the location of the ground which will be the basis
of measurement, select  at the right side of "Ground level".

Specify a point at the base ground position on "3D View" window.
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The Z coordinate value of the picked point is automatically set as "Ground level".

4. Adjust "Polygon accuracy", and click [Execute].


When the polygon model is not to be left after measurement is performed,
disable "Generate polygon for target region".

5. A result dialog will appear. Confirm the volume, surface area, and base area.

6. A polygon model is temporarily created on "3D View" window.
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7. Click [Yes] in the result dialog to save the polygon model.

When enabling "Copy result to clipboard", you can paste the measurement result to
Notepad, etc.

Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

 © 2022 Elysium Page 81 | 164



8.2. Measuring Angle
Specify a plane, a straight pipe, or three points on "3D View" window, and measure the angle
between the same type elements.

1. Select [Home] tab > [Measure] > [Measure Angle] (  ).

2. Specify the target elements (plane, pipe, or among 3 points) on "3D View" window.
To measure the angle of pipes, select two pipe elements (straight pipes) on "3D View"
window.

"Measure Angle" dialog and a preview of the measured position will appear on "3D View"
window.
In "Measure Angle" dialog, you can confirm the angle and the deviation of the axes of the
two straight pipes.
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3. To measure the angle of a plane, select two of the same type element from either a plane
element, CAD modeling face (plane), or a structural face on "3D View" window.

"Measure Angle" dialog and a preview of the measured position will appear on "3D View"
window.
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4. To measure the angle among 3 points, select any 3 points among the cloud vertices and
reference points on "3D View" window.

With a straight line, connect #1 and #2 point, then #2 and #3. Measure the created angle
between these two straight lines. "Measure Angle" dialog and a preview of the measured
position will appear on "3D View" window.
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9. Setting Dimensions & Notes

9.1. Setting Dimension
Users can virtually measure dimensions using point cloud data without going on-site.
Therefore, taking measurements of unsafe locations and heights will not be a problem using
InfiPoints.

9.1.1. Creating Dimension

1. Select [Home] tab > [Create Dimension] (  ) from the Ribbon menu

2. [Option] panel will appear. In this case, select "Shortest Distance".



Please note that if "Section Mode" is enabled in [Section] panel, the
following "Option" dialog will appear.
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3. Pick the starting and ending point of measurement.



If pipes/planes are already extracted, candidates near the mouse cursor
will be highlighted.



Users can use the [Smart Filter] to select certain elements such as
pipes/planes.

It is not possible to specify 2D drawing elements as selection targets;
however, if you generate point clouds from 2D drawings, you can specify
them as selection targets (point cloud vertices). Please refer to "Generating
point cloud from 2D drawing" for details about generating point cloud from
drawing.
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4. The dimension will appear when the starting and ending points are selected.
Users can choose where to locate the dimension annotation when clicking in a selected area.

9.1.2. Creating Dimension (Section Mode)

Users can measure as if on a 2D drawing when viewed from a selected section.

1. In [Section] panel, press [Switch Mode: Clipping/Section] (  ) to enable the Section mode.

2. Select the direction of section. In this case, select "XY (top)" to set the horizontal section.

3. Select the location for cross-section in the 3D View Window. A cross-section which passes
through the selected point will be created.
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4. In [Section] panel, enable "Section Mode".

5. Select [Home] tab > [Create Dimension] (  ) from the Ribbon menu to measure a certain
location.

◦ An example of a dimension viewed from a section
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

Created dimension can be checked in the [Dimension] panel.

9.1.3. Editing Selected Dimension

1. Pick the dimension to edit on "3D View" window.
[Dimension] panel will appear, and the dimension you picked will be highlighted.

2. Right-click on "3D View" window, and select "Edit" from the context menu.
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3. "Display Settings of Dimension" dialog will appear. Edit the name and format of the
dimension, and then click [OK].

9.1.4. Deleting Selected Dimension

1. Select note(s) and dimension(s) to delete in 3D View Window.
[Dimension] panel will appear and selected dimension will be highlighted.

2. Select [Delete the selected elements] (  ) from the quick access tool bar or select [Delete]
to delete the selected dimension.
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

◦ Other elements may be prioritized for the selection when there are
other elements near the dimension or note to move. Utilize [Smart
Filter] in the toolbar to make only "Note & Dimension" selectable.

◦ Multiple selection is available.

▪ Select elements while holding down [Ctrl] key to multiselect.

▪ Drag the mouse while holding down [Ctrl] key to select by a
rectangular area. (Drag without holding down [Ctrl] key if you are
in "Ortho" mode)



◦ Another possible way to delete a dimension is to right-click while the
dimension is selected in [Dimension] panel, and then click "Delete"
from the context menu.
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9.2. Setting Notes or Links
Notes (comments) or links to associated files can be created.
Information necessary for construction can be shared using InfiPoints.

9.2.1. Adding Notes

1. Select [Home] tab > [Add Notes] (  ) from the ribbon menu.

2. Select an element for which you want to add notes on "3D View" Window.


Elements that can have notes added are point cloud, reference point,
polygon, CAD model, and modeling element.

3. A note will be added. Move the mouse cursor to the preferred position on "3D View"
window, and then left-click.
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4. "Edit Note" dialog will appear.　Enter the necessary information, and click [OK].
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

Background or text color of notes can be changed from [Display Settings] of
the category.

◦ An example of notes setting change (color)
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

It is possible to change the setting for all notes. Select [Application
Menu] > [Option] > [Display Preference] > [Annotation].

9.2.2. Editing Notes

1. Select [Home] tab > [Edit Note] (  ) from the Ribbon menu.

2. Pick the note you want to edit on "3D View" window to display the "Edit Note" dialog. Select
[Display Settings] in the dialog.
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3. "Display Settings of Note" dialog will appear.
Disable "Apply common settings" to allow editing the individual settings. Change the display
settings such as font color and background color, and click [OK].
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10. Detecting Collisions

10.1. Importing CAD Data
Import CAD data and/or polygon data into InfiPoints and view them with the point cloud data. A
newly to-be-installed equipment can be imported to examine the after-construction state, for
example.

1. Select [Import] tab > [CAD Model] (  ) from the Ribbon menu.


Select [Data Import] tab > [Polygon Model] (  ) to import a polygon
model.

2. Specify a CAD model and click [Open].

 Users can also drag-and-drop the model for import.

3. "Position of the Model" dialog will appear. Specify the method of placement and click [OK].
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At the center of the
current view

Places at the center of "3D View" window.

At the absolute
coordinate of the
model

Used when the point cloud and model are on the same
coordinate system

At a specified
position
(point/reference
point)

Select a point in the 3D View Window to place the model
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10.2. Detecting Collisions (Manually)
Users can conduct collision check between point cloud data and imported CAD model (or
polygon model). Collision detection can be performed by moving the imported CAD model
inside of the point cloud. This function can be used to check import routes of equipment and
examine a specific location for placement.

 About Accuracy of Collision Detection 

"Collision detection" emphasizes real-time processing, which is more likely to produce
errors than "interference detection". Therefore, depending on the geometry of the CAD
model (or polygon model), collision may be detected even where it did not originally
collide.

For a more accurate interference check, refer to "Detecting Interferences" and it is
recommended that you confirm visually.

1. Import a model to check against collision.


Please refer to 10.1, “Importing CAD Data” for details about importing
models.

2. Select [Analysis] tab > [Detect Collision Mode] > [Detect Collision: ON (Shown Points only)]
(  ) from the Ribbon menu.
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
To make a hidden point cloud part in [Tree] panel the subject of collision
check, select [Analysis] tab > [Detect Collision Mode] > [Detect Collision: ON
(Including Hidden Points)] (  ).

An error message as below will appear if the view mode is changed in layer settings.


Users can disregard the message and detect collisions, but the screen view
may not be accurately reflected.



Select [Analysis] tab > [Detect Collision Mode] > [Regenerate Data for
Collision Detection] (  ) to reflect the current view mode.

3. Select [Analysis] tab > [Move] (  ) or [Move with Restraints] (  ) from the Ribbon menu
to move the CAD data. Specify the model.
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 Move Freely move the CAD model

 Move with Restraints Offset, move in parallel or rotate the CAD model by
restraining them on a plane or axis

 Please refer to "5, Moving Tools" for moving operation.

4. Move the model in "3D View" window.
When there is a collision between the CAD model (or the Polygon model) and the
surrounding point cloud, the CAD model (or the Polygon model) is shown in semi-
transparent blue and the collided area (point cloud) in red.
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10.3. Detecting Collision on Path
Users can check for collisions of imported CAD model (or polygon model) and surrounding
point cloud along a predetermined path. The CAD model (or polygon model) movement path
can be saved as a movie for sharing with others.

Move the CAD model along the path to create a point cloud part which is independent from the
point cloud where it collided.

Preparation for Detecting Collision on Path

• When detecting for any collisions on the path, it is required to set the path in advance
using the motion function. Please refer to 13, Creating a Movie for details about
motion function.

• Please ensure that [Detect Collision Mode] is enabled.

1. Select [Output Creation] tab > [Start Video Creation] (  ) from the Ribbon menu.

2. [Motion] panel will appear. Select the preferred motions to play, and enable "Save collision
detection result" option.
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
Please note that when [Detect Collision: OFF] (  ), you cannot select
"Save collision detection result" option.

3. In [Motion] panel, press [Play] (  ).

4. A confirmation dialog will appear.
Specify the layer to which you want to copy the point cloud with collisions to, and then click
[OK].

5. The process to detect collision points will start. After completing the process, click [OK] in
"Collision Detection" dialog.

A preview of the CAD model moving along the path with collision detection can be seen.
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In [Tree (Overview)] panel, a new point cloud part (Collision Points) consisting only of
collision points will be created.

Also, the created point cloud part (Collision Points) is copied to the specified layer.
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10.4. Detecting Interferences
Select a desired distance from the imported CAD data (or Polygon data), and detect point clouds
within that area. It is also possible to create a point cloud from the detected points.

1. Import CAD model (or polygon model) for interference check.

 Please refer to 10.1, “Importing CAD Data” for details on importing models.

2. Select [Analysis] tab > [Detect Interference] (  ) from the ribbon menu.

3. Select the target model in "3D View" window or [Tree (Overview)] panel.

4. The "Interference Detection" dialog will appear. Specify the distance to detect interference
in "Interference Distance" and click [Execute].
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Number of points detected within the specified "Interference Distance" from the model’s
face and number of points detected inside the model itself will be displayed in the following
dialog.

Also, in "3D View" window, interfering points of the point cloud will be highlighted in red.

5. In the dialog where the number of points appear, click [OK].
In the lower left of "Interference Detection" dialog, [Generate New Point Cloud of Interfering
Points Only (Without scan index)] ( ) will be activated.

6. Click [Generate New Point Cloud of Interfering Points Only (Without scan index)] ( ) to
generate a point cloud from highlighted points.
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The following dialog will appear, so click [Yes] as is.

A red point cloud without scan index data is generated from the red highlighted points on
"3D View" window.
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11. Comparing CAD and Point Cloud
Automatically compare differences between scanned point cloud data and designed CAD data.
This functionality can be used to compare plan and construction result, or to track changes
made on facilities over time.

1. Select [Analysis] tab > [Start CAD Validation] (  ) from the Ribbon menu.

2. [CAD Validation] panel will appear. Press [Add Target Model to the List] (  ) and pick the
target model you want to compare in "3D View" window.


CAD models, polygons, piping elements, piping groups, planes, plane
groups, ducts, duct groups, structures, and structure groups can be
specified for comparison.

3. In [CAD Validation] panel, press [Show Validation Result] (  ).
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4. A "Show fitting difference" dialog will appear. Click [OK].

Colored points and indicators based on the result of calculated differences will appear in
"3D View" window.



The gradation view result in the main screen can be changed by controlling
the value of the [Show difference within] option in the [CAD Validation]
panel.
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12. Managing 2D Drawings

12.1. Creating 2D Drawings
You can create 2D drawings with InfiPoints. Followings are the instruction on how to create a
2D drawing at the position of the section.

Preparing for Creation of 2D Drawings

• 2D drawing is created at the position specified by the section or clipping box.

◦ Enable the [Section] panel by selecting [Switch Mode: Clipping / Section] (  ) if
you want to create 2D drawings by using the section. Also, if you want to create 2D
drawings by using the Clipping Box, enable the [Clipping] panel.



• Please refer to "Create Section" in "InfiPoints Operation Manual Vol.2
Point Cloud Utilization: Simulation & Data Utilization" for ways to
create a section.

• Please refer to "Create Clipping Box" in "InfiPoints Operation Manual
Vol.2 Point Cloud Utilization: Simulation & Data Utilization" for ways
to create a Clipping Box.

 You cannot use [Section] panel and [Clipping] panel at the same time.

1. Select [Output Creation] tab > [2D Drawings] > [Create 2D Drawing] (  ) from the Ribbon
menu.

 Please enable the [Section] panel when creating the 2D drawing.

2. On "3D View" window, a preview of where the drawing will be created is displayed. In
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"Create Drawing" dialog, click [OK].

Edit Drawing Mode is automatically enabled and 2D drawing which includes intersection
curves with planes and pipes is created at the position where the section was created.

A [Drawing] folder will be added to the [Tree (Overview)] panel.
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12.2. Editing 2D Drawings
The existing 2D drawings can be edited.

12.2.1. Switching to "Edit Drawing" Mode

• "First imported drawing" or "lastly created drawing" is set as the editing target when
multiple drawings are in the [Tree (Overview)] panel.

 Pencil mark (  ) is placed on the icon of drawing to edit.

• If you would like to edit another drawing (  ), right-click on the drawing from the [Tree
(Overview)] panel and select [Target Drawing for Edit].

1. Select [Output Creation] tab > [2D Drawing] > [Enable 2D Drawing Edit] (  ) from the
Ribbon menu.

When you are in the [Edit Drawing Mode], your view will be set as a drawing view and
drawing menus will be enabled. You can also select drawing objects to edit or delete.
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12.2.2. Adding Drawing Elements

The drawing elements (Line, Rectangle, Arc, Circle) can be added to the 2D drawings.

■ By connecting 2 selected points

1. Select [Output Creation] tab > [2D Drawing] > [Line] (  ) from the ribbon menu.

2. In [Option] panel, select "By connecting 2 selected points".

3. On "3D View" window, specify the point to start a line.
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4. Specify another point to finish the line on "3D View" window. A line connecting these 2
points will be created.



By holding down [Shift] key and specifying the end point position, you can
create a straight line in parallel or vertical direction.

e.g. Left: without [Shift], Right: with [Shift]

You can continue to create a new straight line from the last selected end point. If you want
to finish adding lines, press [Cancel] (  ).

In the 2D drawings, yellow marks are displayed as guides at corners, intersection of lines,
the center point of lines, intersecting vertically with straight lines, and so on.

■ By drawing from #1 point toward #2 for specified length

1. Select [Output Creation] tab > [2D Drawing] > [Line] (  ) from the ribbon menu.

2. In [Option] panel, select "By drawing from #1 point toward #2 point for specified length",
and enter the length of the line you wish to create.
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3. Select #1 point in "3D View" window to define the start point.

4. Select #2 point in "3D View" window to define the direction.

A straight line from #1 point toward #2 point with specified length will be created.

■ Creating New Rectangles
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1. Select [Output Creation] tab > [2D Drawing] > [Rectangle] (  ) from the Ribbon menu.

2. Click a point to define a corner of a rectangle on the 3D View Window.

3. Click another point which will become the opposite angle of a rectangle on the 3D View
Window. A rectangle is created that connects two points on a diagonal.

You can continue to creat rectangles. To finish adding rectangles, press [Cancel] (  ).

■ Creating New Arcs

1. Select [Output Creation] tab > [2D Drawing] > [Arc] (  ) from the Ribbon menu.

2. Click a point to start an arc on "3D View" window.

3. Click a passing point on the circumference of the arc.
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4. Click another point on the 3D View Window to finish the arc. An arc with these 3 points will
be created.

You can continue creating arcs. To finish adding arcs, press [Cancel] (  ).

■ Creating New Circles

1. Select [Output Creation] tab > [2D Drawing] > [Circle] (  ) from the Ribbon menu.

2. Click the center position of the circle on the 3D View Window. The size of the circle changes
according to the movement of the mouse.

3. Click the point on the circumference. A circle will be created.
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You can continue to create circles. To finish adding circles, press [Cancel] ( (  ).



[Circle by 3 Points] (  ) can be created by specifying 3 points on the
circumference.

12.2.3. Adding Dimensions/Annotations

Dimensions/Annotations can be added to the 2D drawings.

■ Creating New Linear Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Linear Dimension] (  ) from the Ribbon
menu.

2. Click a point to start a line to measure on the 3D View Window.
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3. Click another point to finish the line to measure on the 3D View Window. The linear
dimension is displayed.

4. Specify the position where you want to place the dimension line. The dimension line that
indicates the length in the vertical or horizontal direction is created at the specified position.

■ Creating New Aligned Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Aligned Dimension] (  ) from the Ribbon
menu.

2. Click a point to start a line to measure on the 3D View Window.

3. Click another point to finish the line to measure on the 3D View Window. The aligned
dimension is displayed.
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4. Specify the position where you want to place the dimension line. The dimension line that
indicates the length in the shortest distance is created at the specified position.

■ Creating New Radial Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Radial Dimension] (  ) from the Ribbon
menu.

2. Select an arc or a circle to measure the radius on the 3D View Window. The radial
dimension is displayed.

3. Specify the position where you want to place the dimension line. The dimension line that
indicates the radius of the circle is created at the specified position.

■ Creating New Diametric Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Diametric Dimension] (  ) from the Ribbon
menu.

2. Select an arc or a circle to measure the diameter on the 3D View Window. The diametric
dimension is displayed.
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3. Specify the position where you want to place the dimension line. The dimension line that
indicates the diameter of the circle is created at the specified position.

■ Creating New Angular Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Angular Dimension] (  ) from the Ribbon
menu.

2. Pick the two straight lines measuring the angle on the 3D View Window. The angular
dimension is displayed.

3. Specify the position where you want to place the dimension line. The dimension line that
indicates the angle between the two straight lines is created at the specified position.

■ Adding a New Text

1. Select [Output Creation] tab > [2D Drawing] > [Text] (  ) from the Ribbon menu.

2. Left-click the mouse at the position where you want to place the text note on "3D View"
window. "Text" dialog will appear.
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 The 3D coordinate of the specified position is displayed in the text box.

3. Edit the text box and click [OK] to create the annotation.


◦ You can use control characters, such as \P (line break).

◦ Added text cannot be edited.

■ Adding a Multiple Leader

1. Select [Output Creation] tab > [2D Drawing] > [Multiple Leader] (  ) from the Ribbon
menu.

2. Click on the position where you want to start the leader line on the 3D View Window.

3. Move the mouse cursor and then left-click to fix the location of the leader line. The multiple
leader dialog is displayed.


Please note that the text box displays the 3D coordinates of the position
where the leader line started.
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4. Edit the text in "Multiple leader" dialog and click [OK] to add a new leader.

 Added text cannot be edited.

12.2.4. Moving the Drawing Elements / Annotations / Dimensions

1. Pick an element to move on "3D View" window. Selected element is shown in dotted line
with blue grips.

2. Select a grip you would like to move. Selected grip will be shown in red. As the mouse
moves, the shape of the drawing element changes. Left-click on any point to confirm the
change.

3. Select [ESC] key to confirm all the changes. Edited drawing element will turn back to solid
line.
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12.2.5. Deleting the Drawing Elements / Annotations / Dimensions

1. Left-click on an element to delete on the 3D View Window.

 Multiple drawing elements can be selected at the same time.

2. Select [Delete the selected elements] (  ) from the quick access tool bar or select [Delete]
to delete the selected drawing elements.

12.2.6. Changing the Style of the Drawing
Elements/Annotations/Dimensions

1. Select [Output Creation] tab > [2D Drawing] > [Notes & Dimensions style] (  ) from the
Ribbon menu.

2. "Edit Style" dialog will appear. Change the character size, the number of digits after the
decimal point, etc. and click [OK].
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12.3. Exporting as 2D Drawings
InfiPoints can create drawings, and export them as 2D drawing data (DWG/DXF formats) and
background image data (PNG format). Exported background image data (PNG) can be used as
an image to be placed in the background for AutoCAD and BIM softwares.

1. Select [Output Creation] tab > [Export] > [2D/3D Drawing] (  ) from the Ribbon menu.


Only when "Edit Drawing Mode" is enabled, 2D drawing data (DWG/DXF
formats) and background image data (PNG format) are exported. When
executing "Normal mode", only the drawing data (DWG/DXF format) is
exported.

2. Select the 2D drawing to be exported from the [Tree (Overview)] panel when multiple 2D
drawings are in the panel.

3. "Export" dialog will appear.
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Click [Option] to display "Import/Export Settings" dialog.
Set options and click [OK].

4. In "Export" dialog, specify folder path to save, file name, and file type of 2D drawing, and
click [Save]. 2D drawing file and background image will be exported.

 When exporting the background image, always use "Edit Drawing Mode".
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12.4. Exporting as 3D Drawings
The created modeling elements can be exported as drawing data (DWG/DXF format).
In this case, the modeling piping element will be exported in DWG format.

1. Select [Output Creation] tab > [Data Export] > [Export] > [2D/3D Drawing] (  ) from the
ribbon menu.

2. "Export" dialog will appear. Change the file type to "Drawing File (*.dwg)", then specify the
destination and file name.

3. In "Export" dialog, click [Options].
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"Import/Export Settings" dialog will appear. Select [Export DWG/DXF (3D) File] tab.
Here you can set options to export 3D drawing files.

Because the piping element is exported as solid in this case, enable "As solid model" under
"How to export piping elements".

4. Select [Export Common] tab. You can set export options for each modeling element here.

This time, leave the default settings as is, and click [OK] in "Import/Export Settings" dialog.

5. In "Export" dialog, click [Save].

Drawing data is exported in the specified DWG format.
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

In "Import/Export Settings" dialog, select [Export Common] tab. Check the
option "Export each Piping Group separately" and export the 3D drawing
file. Each piping group can be exported independently as a separate 3D
drawing file.
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12.5. Importing 2D/3D Drawings
You can import 2D as well as 3D drawing data into InfiPoints.

12.5.1. Importing 3D Drawings

1. Select [Import] tab > [Data Import] > [2D/3D Drawing] (  ) from the Ribbon menu.

2. "Import" dialog will appear. Specify the target drawing file to import, and click [Open].

3. "Position of the Model" dialog will appear. In this case, specify "At the absolute coordinate of
the model" and click [OK].
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
Please note that "Position of the Model" dialog will appear only when
importing 3D drawings.

3D drawing file is imported and displayed on both [Tree (Overview)] panel and "3D View"
window.


Please note that the imported 3D drawing files are displayed as "This
drawing includes 3D elements ( )" on [Tree (Overview)] panel. This type
of drawing cannot be edited in InfiPoints.



Select [Home] tab > [Display Status] > [Display Method of Drawings] to
display the extracted planes.
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12.5.2. Importing 2D Drawings

1. Select [Import] tab > [Data Import] > [2D/3D Drawing] (  ) from the Ribbon menu.

2. "Import" dialog will appear. Specify the target drawing file to import, and click [Open].

2D drawing file is imported and displayed on both [Tree (Overview)] panel and "3D View"
window.
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

If 2D drawing ( ) is imported as a 3D drawing ( ), click [Options] in
"Import" dialog. In "Import/Export Settings" dialog, enable "Import as a 2D
drawing".



Select [Display Settings] in either [Top View] or [Front View] panel, and
check the option "Show 2D / 3D drawings" to display the drawing on either
[Top View] or [Front View].
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12.6. Generating Point Cloud from Drawing
With InfiPoints, you can generate point clouds from drawings. By generating a point cloud on a
2D drawing, it becomes possible to perform 3D measurement from the point cloud scanned by a
laser scanner and the point cloud generated from the drawing.

1. On [Tree (Overview)] panel, right-click on the 2D drawing from which to generate the point
cloud. Select "Generate Point Cloud from Drawing" from the context menu.

2. "Generate Point Cloud from Drawing" dialog will appear. Specify the interval to produce
points and the color of point cloud, and click [OK].
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The point cloud is generated in the specified interval and displayed on both "3D View"
window and [Tree (Overview)] panel.


If the point cloud generated from the drawing is difficult to see on "3D
View" window, hide the other elements on the structure tree.



Please note that the option "Produce points at every" is only available for
line data, such as 2D drawings or drawings where only the axes of
modeling elements are output.

For solids, a single point is generated near the center of the element.
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13. Creating a Movie
Multiple viewpoints can be set on "3D View" window, and a movie can be created by connecting
the viewpoints. For example, a movie that looks as if you were actually walking through the
scanned site can be created. This functionality is convenient in sharing information between
the client and the on-site worker before construction.

Preparing Movie Creation

• Select [Output Creation] tab > [Start Video Creation] (  ) from the Ribbon menu.

[Motion] panel and [Path] panel will be displayed.
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13.1. Creating Motion
1. In [Motion] panel, press [Add] (  ).

The current motion will be added to the list on [Motion] panel.



• Right-click on [Motion Name] in the [Motion] panel to change the name of
the motion.



• The target is set to "Viewpoint" by default.

• Check [Execute] checkbox to select motion(s) to play.
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

• Check "Show" in [Motion] panel to toggle show / hide the motion path in
"3D View" window.

Motion selected in [Motion] panel will be shown with light blue line, and
others in orange.

• To delete a motion, press [Delete] ( (  ) while the motion is selected on
the list of [Motion] panel.
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13.2. Creating Path
1. In [Path] panel, select a motion and press [Switch to [Path] Panel] (  ).

2. It will switch to [Path] panel. Press [Edit Path (Create New/Extend Existing Path)] (  ) in
the [Path] panel.

3. "Create New Path" dialog will appear. In this case, select "Horizontal plane" in the working
plane, and then click [Next].

◦ [Horizontal plane] fixes the Z-axis location and creates the path at the same height.

◦ [Vertical plane] creates the path on the vertical cross section.

◦ [Specify any plane] creates a path parallel to the selected plane. This is useful when
creating a path along a slope.
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

Use the settings in the [Option] panel to change the way to create the
path.

4. Click an area in the 3D View Window to set as an origin.
Select a point on the floor in this case.


An origin refers to the reference point of the height when the plane is
viewed from top in the [Section Mode].

5. The cross section plane at the height of the origin is shown in the [Section Mode].
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6. In [Section] panel, use the slide bar in "Move" to adjust the position of the section in order to
create the path at the preferred height.

7. Select nodes (points of path) by clicking the point clouds in the 3D View Window.
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
The red points are nodes. The path is created by connecting these nodes
and drawing a green line.



After creating a path, press [Edit Path (Create New/Extend Existing Path)] (
 ) and "Extend Existing Path" dialog will appear.

◦ Select [Forward] to add nodes from the end of the path and extend the
path.

◦ Select [Backward] to create new nodes on the already created path.

8. In [Section] panel, disable "Section Mode" to return to the normal view.
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13.3. Setting Target
Set the target (viewpoint or model) for created motion. For the target, you can set a viewpoint
or an object (CAD model, polygon model, point cloud part, drawing, or group).

■ Placing a Model

1. In [Motion] panel, click "Target" item and then click "Select a model…" from the drop-down
list.

2. Select the CAD data (or the polygon data) in the [Tree] panel.

3. "Position of Motion Target" dialog will appear. Here, specify the placement method as
follows and click [OK].

a. Specify how to place the target

▪ If the motion target (equipment model) position does not have to be adjusted

▪ Select "Offset from the path".
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▪ If the motion target (equipment model) position needs to be adjusted

▪ Select "Sit on the path".
Use the Move tool or the handles in "3D View" window to adjust the position.

b. Time setting

▪ To start from the initial set node position

▪ Select "As the start time of the motion path".

▪ To start from a specific time during the motion play

▪ Select "As the current time of the motion path". This will start from the position of
the specified time.

The origin of the model will shift to the start point of the motion path.
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
After the model is automatically positioned, the handle in the 3D View
Window can be used to control the position of the model.
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13.4. Preview Video
You can preview the movie in the 3D View Window. Please note that this is to quickly check the
created movie and the resolution will be low.

1. Make sure the target in [Motion] panel is either the "Viewpoint" or the object name which
you want to move.

2. Enable "Execute" to play the preferred motions.



Please note that when the target motion is different, such as "Viewpoint"
and "CAD model", the movie can be played at the same time. Motion with
the same target cannot be played at the same time.

3. In [Motion] panel, press [Play] (  ).

A preview of the model moving along the path detecting collisions can be seen in the 3D
View Window.

Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

 © 2022 Elysium Page 147 | 164



13.5. Editing Nodes

■ How to add nodes at the viewpoint

1. In [Motion] panel, select a motion in the list, and then press [Switch to [Path] Panel] (  ).
[Path] panel will appear.



Please confirm that the name of the selected motion is displayed at the top.

2. Move to where you wish to add a node in the 3D View Window.

3. In [Path] panel, press [Add] (  ). The current viewpoint will be added to the list.

■ How to edit existing path in 3D View Window

1. Press [Edit Path (Modify Existing Path)] (  ).

2. Drag existing nodes to where you wish to move to.
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Or click anywhere on the path to add a new node.

■ How to extend path

1. In [Path] panel, press [Edit Path (Create New / Extend Existing Path)] (  ).

2. "Extend Existing Path" dialog will appear. Select the direction in which you want to extend
the path and click [OK].

3. Guide line will be displayed, so click where you wish to create a new node.

■ Settings on how to turn at nodes

The path between nodes will be connected smoothly by default, but you can also select to
connect breakpoints without maintaining tangential continuity.

1. Select a node to connect without maintaining tangential continuity in the list on [Path]
panel.
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2. Specify the node for the breakpoints.

The smooth path is changed so that it bends at the selected node (without tangential
continuity).

■ How to delete nodes in 3D View Window

1. On [Path] panel, press [Edit Path (Delete Node)] (  ).

2. Click directly on a node in "3D View" window to delete it.
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13.6. Creating a movie file
To export the movie in AVI file

1. In [Motion] panel, press [Create a movie file] (  ).

2. "Create a movie file" dialog will appear.
Specify the frame rate and the time to start and finish the movie.

Specify the resolution from the list, and click [Create].
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3. "Save" dialog will appear. Specify the movie file and click [Save] to output the movie file in
AVI format.
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14. Exporting Files

14.1. Exporting High Resolution Images
This function allows you to export the content displayed on "3D View" window as a high
resolution image.

1. Select [Output Creation] tab > [High Resolution Image] (  ) from the Ribbon menu.

2. "Output Image" dialog will appear. Specify the image size and grid, and then click [Save].


Grid is only available with Ortho mode (  ). 
The display method can be changed in [Home] tab > [Display Method] >
[Ortho View Mode].

3. "Output Image" dialog will appear.　Specify the image filename, and then click [Save].
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Image file will be exported in PNG format.
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14.2. Exporting Projects
You can export a new project by copying only required files from currently-opened project.

Preparation for Exporting Projects

The only files that will be copied to the new project are the files associated with the
elements displayed on "3D View" window. Make sure that only the elements you want to
export are visible on "3D View" window, and if necessary, switch the display state of each
element using the icons in [Home] tab > [Display Method] group.

1. Select [Output Creation] tab > [Data Export] > [Project File] (  ).

2. "Export Project" dialog will appear. Specify the output folder and the output options, and
click [OK].


Refer to [7. Creating Optimal Point Cloud Data for Drawing] > [7.1 Creating
Background Point Cloud Data] in "InfiPoints Operation Manual Vol.1 Data
Pre-processing" for details about the option "Generate Background Point
Cloud".
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

By displaying only the point cloud with scan index created with [Decrease
Resolution of Point Cloud with Scan Index] (  ) and exporting it as
another project, the data size of the project can be significantly reduced.

Please refer to "InfiPoints Operation Manual Vol.1 Data Pre-processing" >
"Managing Project Data" > "Reducing the Data Size of Point Cloud with Scan
Index" for more details.

New project will be exported as the specified folder.



A new folder will be created under the name of "<specified name>_<a serial
number>" if the folder with specified name already exists.

(Example) The folder named "sample_1" will be exported if the folder
named "sample" already exists in InfiPoints folder.
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14.3. Exporting Viewer Files
Export a viewer file from InfiPoints to share the point cloud with users without an InfiPoints
license.

Preparation for Creating the Viewer Files

■ Create a viewing file while retaining the point cloud

• Create filtered point cloud data.
By creating the Viewer File from filtered point cloud, the data size of Viewer File can
be greatly reduced.


Please refer to "Learn with Tutorial" > "Vol.1. Data Pre-processing" >
[Creating Point Cloud Data Optimized for Visualization]" for more
details about creating filtered point cloud data.

Check Off the checkbox of point cloud parts except filtered point cloud data in [Tree
(Overview)] panel.
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■ Create a viewing file without retaining the point cloud

• Create a texture image for planes and pipes.
By exporting the viewing file with only texture, the data size of the viewing file can be
further reduced than when the optimized point cloud data for visualization is used.

(Reference) Example of file size comparison for viewing files

◦ Viewing file created from a source point cloud: 12.9 GB

◦ Viewing file created from an optimized point cloud for visualization: 1.37 GB

◦ Viewing file created from a texture image (without point cloud data): 0.71 GB


When using a computer which does not have a high 3D graphics
performance, it is recommended to output the viewing file in texture.


Please refer to 4, Creating and Editing Texture for more details about
creating texture images.

In [Tree (Overview)] panel, disable all point cloud parts, and then export the viewing
file.
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1. Select [Output Creation] tab > [Viewer File] (  ) from the Ribbon menu.

2. "Export Viewer File" dialog will appear.
Specify the location of the file and the operations permitted to the viewer, and click [OK].


Functions to enable can be set for Viewer Files. Please note that the file is
not encrypted nor protected by any means.


When the checkbox is checked off for point cloud parts not to be exported
in the structure tree, check "Visible elements only" of export option.

3. Viewer files are exported.
Double-clicking the vbs file in the exported folder starts the viewer.
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Viewer File Functionality

1. View point cloud, CAD data, notes and dimensions

2. Switching between show/hide of layers

3. Section movement along a pre-set path

4. Drawing creation, DWG export [*]

5. Ortho image export [*]

6. Adding dimensions [*]

7. Adding notes

[*] Authority settings can be conducted when exporting the viewer file



• The viewer file has the same point cloud rendering capabilities as
that of InfiPoints.

• Users can save drawings, notes, and added dimensions in the viewer
file.

• Distribute both the vbs file and the folder that includes the data file
for the viewer file.
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14.4. Exporting as CAD Models
You can export the created modeling elements in various CAD formats such as IGES, STEP, and
IFC. In this case, the modeling elements are exported in IGES file.



Native CAD export is an optional product. By selecting [Supported Formats
(Import/Export)] (  ) at the top right of InfiPoints window, a list of file types
that can be input/output with current license is displayed.

1. Select [Output Creation] tab > [Export] > [CAD Model] (  ) from the Ribbon menu.

2. "Export" dialog will appear. Change the file type to "IGES file", and specify the destination
and the file name.
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3. In "Export" dialog, click [Options].

"Import / Export Settings" dialog will appear. Select [Export IGES File] tab.
It is possible to set export options for IGES file here.



You can configure export options for the file type corresponding to the
specified file type.

You can configure export options for each modeling element in [Export Common] tab.
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

Options are also configurable from [Application Menu] > [Option] >
[Import/Export Settings].

In "Import/Export Settings" dialog, click [OK].

4. In "Export" dialog, click [Save] to export the CAD model in the specified IGES file type.


If there are multiple CAD data elements in the project file, all the elements
will be exported.

Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

 © 2022 Elysium Page 163 | 164



All rights reserved by Elysium or the original author of this material. The content may not
be edited, reproduced, distributed, transmitted, displayed, published, broadcast, sold or
lent without the prior permission of the author.

Elysium InfiPoints Operation Manual Vol.2. Point Cloud Utilization - Simulation & Data Utilization -

 © 2022 Elysium Page 164 | 164


	Elysium InfiPoints Operation Manual: Vol.2. Point Cloud Utilization - Simulation & Data Utilization -
	Index
	1. Close Look into a Certain Region Only
	1.1. Viewing within Clipping Box
	1.2. Viewing the Section
	1.3. Saving a Scene
	1.4. Saving an Area of Specified Space

	2. Editing Point Cloud Color
	3. Complementing Point Cloud
	3.1. Complementing Point Cloud - Under the Scanner
	3.2. Removing an Object on the Floor
	3.3. Complementing Point Cloud - within Specified Region

	4. Creating and Editing Texture
	4.1. Creating Texture Images
	4.2. Editing Texture Color

	5. Moving Tools
	5.1. Moving Specified Element
	5.2. Position the CAD Model in Place

	6. Edit Layers
	6.1. Move Points in Layers
	6.2. Copy Point Cloud Element of Layer
	6.3. Confirm the Number of Points in the Layer
	6.4. Layer Panel Basic Operation

	7. Generating/Exporting Polygons
	7.1. Generating Polygons from Point Clouds in a Specific Layer
	7.2. Exporting Generated Polygon Data

	8. Measuring
	8.1. Measuring Volume and Surface Area
	8.2. Measuring Angle

	9. Setting Dimensions & Notes
	9.1. Setting Dimension
	9.2. Setting Notes or Links

	10. Detecting Collisions
	10.1. Importing CAD Data
	10.2. Detecting Collisions (Manually)
	10.3. Detecting Collision on Path
	10.4. Detecting Interferences

	11. Comparing CAD and Point Cloud
	12. Managing 2D Drawings
	12.1. Creating 2D Drawings
	12.2. Editing 2D Drawings
	12.3. Exporting as 2D Drawings
	12.4. Exporting as 3D Drawings
	12.5. Importing 2D/3D Drawings
	12.6. Generating Point Cloud from Drawing

	13. Creating a Movie
	13.1. Creating Motion
	13.2. Creating Path
	13.3. Setting Target
	13.4. Preview Video
	13.5. Editing Nodes
	13.6. Creating a movie file

	14. Exporting Files
	14.1. Exporting High Resolution Images
	14.2. Exporting Projects
	14.3. Exporting Viewer Files
	14.4. Exporting as CAD Models


